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Excel Basics 

Import a Text File into Excel 

1. Open Excel. 
2. From the menu, select Data  From Text. 

  
 

3. Open the text file you want to import. 
4. Then, select which file type describes the data. 

 
 

a. The “Delimited” option lets you choose how the data will be separated into 
columns. For example, if you select Tab, it will separate the columns by each 
tab break.   
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b. The “Fixed width” option allows you to manually move the bars to separate 
the columns. To create a break line, click at the desired position. To delete a 
break line, double-click on the line. To move a break line, click and drag it. 
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To ensure any leading zeroes will not be dropped, you must change the number column(s) to 
text. 

1. Under “Data preview”, click to highlight one or multiple columns to change them to text. 
If you need more than one column, highlight multiple columns by using the Ctrl or Shift 
keys. 

2. Under “Column data format”, click on the radio button next to Text.  

 
 

3. Click Finish. 

Text to Columns 

Use this feature if you want to split apart a column into multiple columns. You will need to 
insert the number of columns to hold the data. Note: If you do not insert columns, the Text to 
Columns will overwrite any existing data columns.   

1. From the menu, select Data  Text to Columns. 

 
 

2. Choose the file type that best describes your data. 
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a. “Delimited” allows you to select characters, such as commas or tabs, to separate 
each field into a new column in the spreadsheet. This screen allows you to set 
the delimiter your data contains. You can view how you text will be affected in 
the “Data preview” screen. 

b. “Fixed width” allows fields to be aligned into columns with spaces between each 
field. This screen allows you to set the field widths for the column breaks. To 
create a break line, click at the desired position. To delete a break line, double-
click on the line. To move a break line, click and drag it. 

 
 

3. This screen lets you select each column and set the data format.   
a. Hold down the Ctrl or Shift keys and click on each column.   
b. Now click on the Text radio button. Note: If you do not change the columns to be 

text, it will drop all leading zeroes in your spreadsheet. If you are working with 
UFARS codes, it will return bad data without leading zeroes. 

c. “Destination” is telling you it will be replacing the information in the columns 
beginning with that column and cell. If you don’t want the existing columns to be 
overwritten, insert the number of columns needed before beginning the process.  

d. Click Finish. 
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Sorting Data 

There are sorting capabilities when working in Excel. 
1. Highlight the data you want to sort. 
2. From the menu, select Data. 
3. Click on an icon based on the sorting that needs to be done.   

o   Sorts ascending from A to Z. 

o   Sorts descending from Z to A. 

o   The custom Sort box allows you to make multiple sorting selections. 

Custom Sort  

The custom Sort option allow a user to do a detailed sort.   
1. Highlight the data you want to sort. 
2. From the menu, select Data. 

3. Click on the Sort  icon.   
4. Select the sorting selections you would like to use on the selected data. 

a. Add Level. Inserts a row to sort by. 
b. Delete Level. Removes a row to sort by. 
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c. Copy Level. Copies the highlighted row. 
d. Up Arrow. Moves the highlighted sort selection up. 
e. Down Arrow. Moves the highlighted sort selection down. 
f. Options. Gives orientation of sorting from top to bottom or left to right. 
g. My data has headers. Click in the checkbox if you have a header row and want 

to use it to sort the data. This also prevents the header row(s) from being sorted 
into the data. 

h. Column. Use the dropdown arrow to select the columns you want to sort on. 
i. Sort On. Use the dropdown arrow to select Values, Cell Color, Font Color, or Cell 

Icon. 
j. Order. Use the dropdown arrow to select the sort order, A to Z, Z to A, or 

Custom List. 

 
 

5. Click OK. 

Filtering Data 

There are filter capabilities when working in Excel. 

Create a Data Filter 

1. To filter data, click on the row containing the column headings you would like to filter 
on. 

2. From the menu, select Data. 

3. Click on the Filter  icon. This adds dropdown options to your header row. It allows 
you to filter data to narrow down the amount of information that is viewable.   

a. By unchecking the “(Select All)” box, you will be allowed to check any data listed 
in the dropdown. 



Microsoft Office Excel 2016 

 

Region V Computer Services Page 10 
 

 
 

b. To create custom filters, you can click on Text Filters from the menu. This will 
give additional options to filter by, such as: 

1) Equals 
2) Does Not Equal 
3) Begins With 
4) Ends With 
5) Contains 
6) Does Not Contain 
7) Custom Filter 

 

Remove/Clear a Data Filter 

There are several options to remove or clear a data filter. 

 Option #1 
1. Click on the dropdown arrow in the field you want filters removed. 
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2. This will open up the filter box. Select the checkbox next to “(Select All)” to 
display all data. 

 
 

3. Click OK. 
 

 Option #2 
1. Click on the dropdown arrow in the field you want filters removed. 
2. This will open up the filter box. Click on “Clear Filter From xxx”. 

 
 



Microsoft Office Excel 2016 

 

Region V Computer Services Page 12 
 

 Option #3 
1. From the menu, select Data. 

2. Under Sort & Filter, select the Clear  icon. 
 

 Option #4 
1. From the menu, select Data. 

2. Under Sort & Filter, select the Filter  icon. This will turn the filter option off. 

Transpose Data 

This option takes data from a horizontal listing to a vertical display or from vertical to 
horizontal. 

 
 

1. Highlight A1 to E6. 
2. Right mouse click and select Copy. 
3. Click in the cell where you would like to insert the new formatted listing. 
4. Right mouse click and select Paste Special. 
5. Click the Transpose box. 
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6. Click OK. The results are below. 

 

Creating a Dropdown List 

1. Click in the cell you would like to create the dropdown list. 
2. From the menu, select Data  Data Validation. 
3. Under Allow, select List. 

4. Click  in the Source field. 
5. Highlight the cells that include the information you want to appear in the dropdown list. 
6. Click Enter. 

 
 

7. Click OK. 
8. Copy the cell down into the cells that you wish to control with the dropdown list. 

 

Hyperlinks 

Hyperlinks create a shortcut that jumps to another location in the current workbook or opens a 
document stored on a network server, intranet, or internet. When you click on a cell that 
contains a hyperlink, Excel jumps to the location listed or opens the document you specified. 
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Create a Hyperlink to an Internet Website 

For an internet website hyperlink, type the website address into a cell and exit the cell. It will 
automatically underline the website address and create a hyperlink. Just click on the link to be 
taken to the website. 

 

Create a Hyperlink to Open an Existing File 

A user can create a hyperlink on a worksheet to take you to another file. 
1. Click in the cell you want the hyperlink to appear. 

2. From the menu, select Insert  Hyperlink . 
3. Select “Existing File or Web Page”. 
4. Enter in what you want to appear in the cell as the hyperlink name in the “Text to 

display:” field. 
5. In the “Look in:” field, locate the file you want the hyperlink to open. 
6. Click OK. 

 
 
The hyperlink appears in the cell selected. 

 

Create a Hyperlink to Jump to Another Worksheet Within the Excel Spreadsheet 

A user can create a hyperlink on a worksheet to take you to another worksheet within the same 
Excel spreadsheet.   

1. Click in the cell you want the hyperlink to appear. 

2. From the menu, select Insert  Hyperlink . 
3. Select “Place in This Document”. 
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4. Enter in what you want to appear in the cell as the hyperlink name in the “Text to 
display:” field. 

5. Under “Or select a place in this document:”, select the worksheet you want the 
hyperlink to take you to. 

6. Click OK. 

 
 
The hyperlink appears in the cell selected. 

 

Create a Hyperlink Button 

For the hyperlink, you can create a button to be selected rather than the underlined text. Below 
is the process to create a simple button that looks like the following. 

 
 

1. On the Menu, select Insert  Shapes. 

2. Select the Textbox  icon. 
3. Draw a textbook in the cell(s) you want the button to appear. 

4. Right mouse click on the textbox and select Format Shape . 
5. Select the items you would like the button to have, like a solid fill color of green with 

a width line of 2. 
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6. Select Effects . 
7. Select the items you would like the button to have, like a shadow and 3-D format. 

 
 

8. Click on the button and type what should appear on the button. Formatting can be 
added to the text. 

9. Right mouse click and select Hyperlink. 
10. Create your hyperlink. 
11. Click into another cell. 
12. Now, when you click on the button, it will direct you to the location you requested. 
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Excel Formulas 

Relative Formula Reference 

A relative reference is a cell reference in a formula that changes when a formula is copied from 
one position to another to reflect the new position. You are copying a “pattern” from one cell 
to another. Relative references contain a cell’s column and row heading. Values are relative and 
are not fixed. It doesn’t copy the absolute formula, it copies the pattern to that formula and is 
called a relative formula.  
 
For example, if you type this formula into column C, =sum(C1:C20), and copy this formula as a 
relative reference into column D, it appears as =sum(D1:D20). 

Absolute Formula Reference 

An absolute reference is a cell reference in a formula that doesn’t change when the formula is 
copied from one position to another to reflect the new position. Absolute references are used 
in formulas to refer to the values in the cells that need to be constant while performing 
calculations. A dollar sign ($) is used before the column and row heading in the cell reference to 
make it constant. By clicking in the formula reference you want to make absolute, hit the F4 key 
and it will add the dollar sign ($) to the formula automatically. 
 
For example, if you type the formula, =sum(A3+$A$1), cell A1 will always be included in the 
formula. 

Mixed Formula Reference 

A mixed reference is a cell reference that contains both an absolute and a relative reference. An 
example might be that cell A1 holds the value of 2%. You want to take 2% of changing cells but 
do not want A1 to change. This is an absolute reference; a fixed cell. 
 
For example, if you type this formula into column A, =sum($A$1*A20), and copy this formula 
into column B, it appears as =sum($A$1*B20).  

Concatenate Formula 

If you want to merge columns together (combine strings of data), you can use the concatenate 
feature in Excel. A good example of this would be Last Name and First Name that is stored in 
two columns in the file. The concatenate feature can be used to merge these two columns into 
one column. There is two ways to do this. 

 
 

 Option #1 
o Type the formula (=B2&” “&A2) into the cell you want the information 

combined. 
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o This formula will take B2 (John), add a space, and then add A2 (Doe) to cell 
C2. Any alpha characters, including a space, needs to be typed inside the 
quotation marks. 

 Option #2 
o Type the formula (=concatenate(B3,” “, A3) into the cell you want the 

information combined. 
o This formula will take B3 (Bob), add a space, and then add A3 (Smith) to cell 

C3. Any alpha characters, including a space, needs to be typed inside the 
quotation marks. 

 
If you want to copy down the formula, you will click on the little square in the lower right-hand 
corner of the field and double-click or pull down to copy. 

 
 
If you want to delete the original columns A and B, you need to copy and paste the new 
concatenated column C as a value.  

1. Right mouse click on column C and select Copy. 
2. Right mouse click on column C again and select Paste Special. 
3. Select Values. 
4. Click OK. 
5. Columns A and B can now be deleted. 

PROPER or UPPER CASE Formula 

Within Excel, you are able to change text from all capital letters to the first letter being capital 
using the PROPER formula. Also, you are able to change text from the first letter being capital 
to all the text being capital using the UPPER CASE formula. 

 
 
PROPER Formula (Using Example Above) 

 Type the formula, =PROPER(A2), into the cell you want the information to appear.   

 Then, you can copy the formula down, if needed. 
 
UPPER CASE Formula (Using Example Above) 

 Type the formula, =UPPER(E2), into the cell you want the information to appear. 

 Then, you can copy the formula down, if needed. 
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LEFT or RIGHT Formula 

Within Excel, you are able to break out information from one cell using the LEFT or RIGHT 
formula. The LEFT formula will capture the first or last characters from the start of a text string. 
If a positive number is entered for the length, it will start from the beginning. If a negative 
number is entered for the length, it will exclude the ending characters. The RIGHT formula will 
capture the specified number of characters from the end of a text string. 

 
 
LEFT Formula (Using Example Above) 

 Type the formula, =LEFT(A2,(LEN(A2)-7)), into the cell you want the information to 
appear. This will capture all characters, except for the last seven (7), since the length 
number was a -7. 

 Then, you can copy the formula down, if needed. 
 
RIGHT Formula (Using Example Above) 

 Type the formula, =RIGHT(A2,4), into the cell you want the information to appear. This 
will capture the last four (4) characters. 

 Then, you can copy the formula down, if needed. 

ROUND Formula 

A ROUND formula rounds a number to a specified number of digits. This is especially helpful 
when multiplying cells in a formula. 
 
The example below is creating a 2% increase to $33,333.00. Based on the last number of the 
formula, 0, 1, or 2 will determine how the answer rounds. 

 

TEXT Formula 

The TEXT formula lets you change the way a number appears by applying formatting to it with 
format codes. It’s useful in situations where you want to display numbers in a more readable 
format or combine numbers with text or symbols. It’s best to keep your original value in one 
cell and use the TEXT formula in another cell. 
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Using Dates to Calculate Values 

Today’s Date and Current Time 
To add today’s date and current time to your spreadsheet type in: =Now().   
 
If you want to remove the time from a single cell, change the cell format to be a date only. 

1. To edit the cell format, right mouse click on the cell you just entered the formula into. 
2. Select Format Cells from the list. 

 
 

3. Under “Category”, select Date. 
4. Under “Type”, select the date output you want to appear. 
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5. Click OK. 

 
If you want to remove the time from an entire column, change the column format to be date 
only. 

1. Click on the column letter(s) to highlight the entire column. 
2. On the Home menu, click on the dropdown box in the “Number” area. 

 
 

3. Select a date format either by selecting Short Date, Long Date, or More Number 
Formats. 



Microsoft Office Excel 2016 

 

Region V Computer Services Page 22 
 

 

Calculating Years of Service 

The following process will identify the number of years from today’s date. For example, this 
could be used to identify the years of service for specific people. 

 
 
Years of Service Calculation (Using Example Above) 

 Type the formula, =ROUND(($B$1-B3)/365,0) into the cell you want the information to 
appear. 

 Then, you can copy the formula down, if needed. 
 
The ROUND function is added to the formula, so the answer can be rounded to a full year. The 
“,0” at the end of the formula states you want to round the answer to the nearest full year. If a 
“,1” was entered, it would round the answer to the nearest tenth. The dollar sign ($) used in the 
formula makes it an absolute reference where each formula uses this date as a constant. Also, 
dividing by 365 represents 365 days in a year. 
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Copying Formulas as Values Only 

If you wish to convert the formula to an actual number, you can accomplish this by using the 
“Copy Here as Values Only” feature of Excel. 

1. Highlight the column or cell with a formula that you want to convert to a number. 

2. Move your mouse to the right side of the cell or column until you see . Right mouse 
click and hold the right mouse button down. 

3. Move your mouse to another cell where you want the information to appear while 
continuing to hold the right mouse button. 

4. Release the right mouse button. 
5. Select “Copy Here as Values Only” from the options. 

 

VLOOKUP Formula 

The VLOOKUP formula is used when you need to find a value in a table. It has three arguments 
that appear in the following order: lookup value, table array, and column index number.   

 The lookup value is the value you are looking up in the first column of the table. It can 
be a value, a test string, or a cell reference.   

 The table array is the range address of the table of information.   

 The column index number is the number of columns Excel counts over to the right from 
the first column in the table. 

In the example below, the data contains teacher demographics. A separate table contains the 
teacher’s file folder number (FFN). The VLOOKUP formula can be used to add the file folder 
number to the demographic record. 

 
 
Enter the following formula in cell F4, FFN (file folder number). 

 Lookup_value = A4. Field containing the employee ID. 

 Table_array = $H$4:$I$349. Range that contains the file folder number. Note: Use 
absolute reference to define the table range. 
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Quick tip: To quickly select a range of cells use Ctrl + Shift + Arrow Key . 

Then repeat going down Ctrl + Shift + Arrow Key . 

 Col_index_num = 2. Indicates which column in the table contains the value you want 
returned. 

 Range_lookup 
o TRUE = Approximate Match 
o FALSE = Exact Match 

 
 
To quickly copy the formula down the spreadsheet, double-click on the “box” in the lower right 
corner of cell F4. 

 
 

The file folder number is now linked to the employee demographics. 
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To view the formula, from the menu, select Formulas  Show Formulas. 

 
 

 The “lookup table” could be on another worksheet or it could be in another 
workbook.   

o To identify a workbook, it has to be in square brackets.  [     ] 
o To identify a worksheet, you type in the name of the worksheet followed by 

!. 
o Assume the file folder number is in a separate worksheet named FFN. The 

formula used would look like this:  

=VLOOKUP(A4,FFN!$H$4:$I$349,2,false) 
 

Quick tip: Need more help with this feature? Type in =VLOOKUP, double-click on VLOOKUP, 
now hover over it until it turns blue and click on the blue link for help.

 

INDEX and MATCH Formulas 

The INDEX formula can be very useful when referencing a salary schedule within a spreadsheet. 

 The INDEX formula returns a value for a range using a row index for a vertical range or 
column index for a horizontal range or both for a two-dimensional range. 

 The MATCH formula searches for a value or text and returns the relative row or column 
in which the item was found. 

Teacher Matrix Example  
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In the Teacher Matrix Example, the following formula was entered in cell E12 (Annual Contract) 
for BARR, DARLENE.  

 =INDEX($A$2:$G$8,MATCH(D12,$A$2:$A$8,0),MATCH(C12,$2:$2,0))*B12 

 $A$2:$G$8   Range that contains the Teacher salary schedule; steps and lanes. 

 D12   Employee Step placement 

 $A$2:$A$8 Find an exact match for the Step by searching the range of cells. 

 C12  Employee Lane placement 

 $2:$2  Find an exact match for the Lane using all cells found in row A2 – G2. 

 B12  Employee FTE value 
 

Good to know: 
 The formula exists in the column rows named “Annual Contract (matrix * FTE)”. 
 The formula is doing a “lookup” using the teacher matrix to find the Lane and Step for 

each employee name.  
 The index defines the column/row range to look in.   
 The match searches for a value within the index range of cells. 
 The 0 in the formula identifies that you are looking for an exact match. 

Benefit Rates by Bargaining Unit Example 

 
 
Health Benefit 
Formula used in column E.
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This formula finds the value for cell E11 by: 
1. Matching the Health Coverage found in cell D11;  
2. with the range of cells for Health Coverage, or range A2:A8; 
3. for the Bargaining Unit type found in cell C11;  
4. with the index range of cells for the Health Coverage by Bargaining Unit, or range A2:G8;  
5. the calculation is then taken times the FTE found in cell B11. 

 
Life Benefit 
Formula used in column G. 

 
 
This formula finds the value for cell G11 by: 

1. Matching the Life Coverage found in cell F11;  
2. with the range of cells for Life Coverage, or range I2:I8; 
3. for the Bargaining Unit type found in cell C11;  
4. with the index range of cells for the Life Coverage by Bargaining Unit, or range I2:O8;  
5. the calculation is then taken times the FTE found in cell B11. 

Data Tools 

Conditional Formatting 

Conditional Formatting in Excel enables you to highlight cells with a certain color, depending on 
the cell’s value. This is helpful when analyzing data. Based on the conditions specified, if they 
are true, the cell is formatted. If false, the cell is not formatted. 

Find duplicate employee IDs 

In the example below, the employee demographics may have more than one row per 
employee. To find these rows, highlight the column containing the employee ID, then click on 
the Home tab. Under the Styles section, select the down arrow on Conditional Formatting. 
From the pop up box, select Highlight Cells Rules  Duplicate Values.   
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The Duplicate Values box appears.   

 Format cells that contain: Duplicate. 

 Values with: Choose color scheme. 

 Click OK. 

 
 
Employees with more than one row in the file are highlighted, so further analysis can be done. 

 

Remove Duplicates 

Using the above example, if Conditional Formatting finds duplicate employee IDs and the 
information in all rows is the same, the duplicate information can easily be removed. This is 
completed by highlighting the data columns. From the menu, select Data  Remove 
Duplicates. 

 
 
The Remove Duplicates box appears. Additional selections can be made or click OK to accept 
the default. 
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A message appears telling you how many values were removed and how many unique values 
remain. Click OK. 

 
 
In the example below, note only one row remains for employee ID 4605. 

 

Remove Blanks 

Sometimes the data we are working with contains blank rows. In the example below, there is a 
blank row between each employee row. 

 
 
To easily remove the blank rows, complete the following steps.   

1. Highlight a column containing a blank value.   
2. From the menu, select Home  Find & Select. 
3. A selection list appears. Click on “Go To Special...”.   
4. A message box appears. Click in the radio button for Blanks. 
5. Click OK. 
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Cells containing a blank value are “grayed out”.  

 
 
6. From the menu, select Home.   
7. Click on the down arrow on Delete. 
8. A selection list appears. Select Delete Sheet Rows. 
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Blank rows are removed. 

 

Subtotals 

To add subtotals to your spreadsheet, click between Column A and Row 1  
to highlight the entire spreadsheet and select the Data tab from the menu. Then, click on 
Subtotal found under the Outline section. This brings up the Subtotal selection box. 

 
 

 At each change in: You define how the spreadsheet should do the subtotals. For 
example, you can subtotal by Program. 

 Use function: You define what function should be used for subtotaling. SUM gives 
you a “subtotal” amount of the cells selected. COUNT returns a “count” of the cells. 
AVERAGE returns the “average” of the cells you selected. 

 Add subtotal to: What fields should have subtotals displayed? You can display 
subtotals for several columns. 

 Remove All. You will click on this button if you want to remove all subtotals and 
start over again. 

Collapse/Expand Detail Rows 

Notice that after you subtotal your spreadsheet you now have numbers in the upper left-hand 
corner of the spreadsheet of 1, 2, and 3.    
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 Click on 1 in the upper left-hand corner of the spreadsheet to see Grand Total. 

 
 

 Click on 2 in the upper left-hand corner of the spreadsheet to see Subtotals by the 
item you added subtotals to. In this example, we used Pro [Program]. Note: To see 
detail, click on the expand and collapse options (+/-) on the left side of the rows. 

 
 

 Click on 3 to return to the detailed spreadsheet. 

 
 

Quick tip: When the subtotal is collapsed, you can format (bold, color, etc.) just the subtotals. 
This formatting style will stay on the detail page, too. This makes a good visual to those viewing 
the spreadsheet data. 

Groups and Outlines 

Excel spreadsheets can contain very large amounts of data. To quickly view pertinent information, 
you can group data together to create outlines. An Excel outline groups the data by their headings. 
To view data on the spreadsheet, click the outline to expand or collapse its section.  
 
To begin, determine the columns (or rows) you want to collapse and drag the mouse cursor over 
them to highlight the selection. From the menu, select Data  Group. 
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This example contains employee demographic and salary information. The demographic 
information (columns C through N) are grouped together, so the data can be collapsed quickly to 
view only salary information (columns O through T). 

 
 
Click on Outline 1 to view salary information. To view detail, click on Outline 2 or the expand and 
collapse options (+/-) at the top of the spreadsheet. 

 
 

Quick tip: More than one outline can be created per spreadsheet allowing multiple ways in 
view data. To remove an outline, highlight the columns used in the group and click on Ungroup. 
If using multiple outlines on a spreadsheet, they can all be removed at once by selecting 
Ungroup  Clear Outline. 

 

PivotTables 

Database Basic Rules 

 An entire row or column should never be blank in the range of data.  

 A cell is allowed to be blank.   

 Each row is a record in the database.   

 The columns are fields. 

 It is a good idea to label the first row in a column.   

 Use a unique font or style to label the column, so it is different from the data in the 
column. If you do, it will be easy for Excel to identify it as a label.   

 Excel uses labels to create reports and to find and organize data. 

PivotTable and PivotChart Report 

The PivotTable feature of Excel is an easy and powerful way to analyze data. It displays 
summary information from particular fields of a database. After the PivotTable has been built, 
you can rearrange the tables, rows, or columns to allow different views of the data.   
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There are four things to consider when creating a PivotTable. 
1. What do you want to use as the Row Headers? 
2. What do you want to use as the Column Headers? 
3. What data do you want to analyze? 
4. Do I need to subdivide it into separate reports or pages? 

General PivotTable Rules 

 Before you start the PivotTable, all columns must be named (labeled). 

 You need more than two criteria of data to work with – otherwise you have nothing to 
pivot. 

Creating the PivotTable 

1. Click into any cell in the worksheet. 

2. From the menu, select Insert  PivotTable  . 
3. The Create PivotTable selection box appears. 

 
 

a. Select or verify the table or range is correct. 
b. The PivotTable report will be placed in a New Worksheet by default. It can be 

changed to an Existing Worksheet. 
c. Click OK to begin designing the PivotTable. 
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4. On the left side is the layout area.  The right side is the PivotTable Fields list. 

 
 

5. Design the report by clicking the field name to include in the PivotTable and dragging it 
to the lower section of the setup window. There are four boxes at the bottom of the 
PivotTable Fields list. You can drag fields to the areas of Filters, Rows, Columns, and 
Values. 

6. To remove a field from the report, deselect it from the PivotTable Fields list. To remove 
all fields, from the menu, select PivotTable Tools  Analyze  Clear  Clear All. 

7. If you click outside the layout area, the PivotTable Fields list goes away. Click inside the 
layout area to get the list back. 

8. To change the formula for the values that you are analyzing, click on the field in the 
Values section and a dropdown will appear that will allow you to change from count to 
sum, etc. 
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9. If you would like to insert a calculated field, from the menu, select PivotTable Tools  
Analyze  Field, Items, & Sets  Calculated Field.  

 
 

10. Name your new field. 
11. Enter the formula you would like to calculate. You can double-click from the Fields list to 

insert into the Formula line. 

 

Hide/Show Fields & Sort 

Click on the dropdown arrow to hide/show rows or columns. You can also choose to sort in 
ascending or descending order. Or, you are able to choose More Sort Options.  
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Refreshing the Data in a PivotTable 

The PivotTable is linked to the source data. However, it will not automatically update each time 
a change occurs in the source data. You need to refresh the PivotTable. 

1. Click inside the PivotTable. 
2. Right mouse click in the PivotTable and choose Refresh. 
3. Or, from the menu, select PivotTable Tools  Analyze  Refresh  Refresh All. 

 

PivotChart 

Once your data is presented in a PivotTable, you can easily ask for it to be displayed as a chart.   
1. Click in the PivotTable data.   
2. Press the F11 key to quickly create the chart in a separate worksheet. 
3. Or, to create a chart in the same worksheet as the PivotTable, from the menu, select 

PivotTable Tools  Analyze  PivotChart. Select the type of chart you would like. Then, 
a chart is automatically created for you on the same worksheet. 

 

Note the + / - 

drilldown indicators. 

They let you know if 

more or less detail of 

the PivotTable can be 

shown. 
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Slicers 
Slicers provide buttons that you can click to filter table data or PivotTable data. In addition to 
quick filtering, slicers also indicate the current filtering state, which makes it easy to understand 
what exactly is shown in a filtered PivotTable. In order to use a slicer, you must convert your 
data into a table first. Note: If you are working with an Excel file created from SMART, you will 
need to convert the spreadsheet to the latest version. 

 
 

When you select an item, it is included in the filter and the data for that item will be displayed 
in the report. For example, when you select Administration in the Prog Series Desc field, only 
data that includes Administration in that field are displayed. You can use a slicer to filter data in 
a table with ease. 
 

Use a Slicer to Filter Data 
1. Click anywhere in the table. 

2. From the menu, select Insert  Slicer . 
3. Select the fields you'd like to filter. 
4. Click OK and adjust your slicer preferences, such as Columns, under Options. 

5. Select Clear Filter to clear the slicer filter. 
Note: To select more than one item, hold Ctrl and select the items that you want to show. 
Select and hold the corner of a slicer to adjust and resize it. 
 

  

https://support.office.com/en-us/article/create-and-format-tables-e81aa349-b006-4f8a-9806-5af9df0ac664
https://support.office.com/en-us/article/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576
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Appendix A – How to Create a PivotTable for MN SEDRA Reporting Data 
The following are directions on how to create a PivotTable from the data obtained from the MN 
SEDRA Reporting found in SMART. This information may be helpful is completing the SEDRA vs. 
UFARS year-end reconciliation process. 
 

1. In SMART, go to Payroll  General Ledger-Pay. 
2. Under Reports, select “MN SEDRA Reporting”. 
3. Complete the following items: 

a. Select Report = Special Ed or Special Ed by Acct 
b. Select Report = Summary 
c. Acct Structure = The format your UFARS codes are listed. 
d. Labor Flag = Pay 
e. Accounting Date = 07/01/20xx to 06/30/20xx 
f. Account Code = Enter in the specific segments for the information you want to 

obtain, like Finance = 740. 

 
 

4. Click Create. 
5. Click Save as Excel File. 
6. Click Save settings and Generate Excel Spreadsheet. 
7. Notice the path of the file. Go to that location and save the file to another location, so 

it’s not accidently overwritten. 
8. Open up the Excel file. 
9. Delete all columns except for those named Employee, Account, Folder, TRA Days, and 

Expend. If you don’t need the Folder or TRA Days columns, you can delete them. 
10. Delete the rows at the top until you get to the column headings identified above. 
11. Insert 5 columns to the right of the account code. 
12. Highlight the Account column. 
13. Click Data  Text to Columns. 
14. Select Fixed width.  Click Next. 
15. Click between each segment. Click Next. 

16. In the Destination field, click . 
 

17. Highlight the 6 columns for each segment to appear individually. Click the X to close the 
window. 

18. Under Data preview, highlight all of the columns and click on the Text radio button. 
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19. Click Finish. 
20. When the following message appears, click OK. 

 
 

21. Change your headings to what you want, especially with the account code segments. 
22. Select the Data tab and Filter. 
23. Select one of the segments filter. 
24. Deselect “(Select All)”. 
25. Select “Blanks”. 
26. Click OK. 
27. Delete all of these lines as the totals by employee are not needed. 
28. Select “(Select All)” again. 
29. Click OK. 
30. Delete the Grand Total at the bottom of the data. 
31. Click on the Insert tab and PivotTable. 
32. In the Create PivotTable window, review the options selected.  Click OK. 
33. In the PivotTable Fields window, select the fields you want included in the PivotTable. 

Then, drag the fields to the various areas based on what you might want to search on.  
Below is an example. 
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34. If the PivotTable layout doesn’t appear like it does below, complete the following: 

 
 

a. Click on the PivotTable Tools “Design” tab. 
b. Click on Report Layout. 
c. Click on Show in Outline Form. 
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35. To remove the subtotals, like Employee, right click on the field heading and deselect 
Subtotal “Employee”.  Or, select “Field Settings” and click on “None”.  You may want to 
remove all the subtotals. 

  or  
 

36. Format the columns and adjust column widths. 
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37. The file layout should look like this with a Grand Total at the bottom of the report. 

 
 

38. The district can now filter by Program to get the cost per employee by disability area. 
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Appendix B – Excel 2016 Shortcut Keys 
The Excel 2016 Shortcuts document on the next page was obtained from 
https://www.wallstreetprep.com/knowledge/excel-shortcuts/. 

https://www.wallstreetprep.com/knowledge/excel-shortcuts/
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Find shortcuts for previous Excel versions at 
at www.wallstreetprep.com/excel-shortcutsExcel 2016 Shortcuts

Edit

Copy Ctrl  + C Ctrl  + C

Paste Ctrl  + V Ctrl  + V

Undo Ctrl  + Z Ctrl  + Z

Redo Ctrl  + Y Ctrl  + Y

File

Open Ctrl  + O Ctrl  + O

New Ctrl  + N Ctrl  + N

Print Ctrl  + P Ctrl  + P

Save Ctrl  + S Ctrl  + S

Save as F12 ⌘  +   + S

Go to next workbook Ctrl  + Tab ⌘  + ~

Close file Ctrl  + F4 Ctrl  + W

Formatting

Open Format Cells dialog Ctrl  + 1 ⌘  + 1

Bold Ctrl  + B ⌘  + B

Italic Ctrl + I ⌘  + I

Underline Ctrl  + U ⌘  + U

Number format Ctrl  +   + ! Ctrl  +   + !

Percent format Ctrl  +   + % Ctrl  +   + %

Date format Ctrl  +   + # Ctrl  +   + #

Increase font size Alt   H   FG ⌘  +   + >

Decrease font size Alt   H   FK ⌘  +   + <

Insert/edit comment   + F2   + F2

Increase decimal Alt   H   0

Decrease decimal Alt   H   9

Increase indent Alt   H   6 Ctrl  + M

Decrease indent Alt   H   5 ⌘  +   + M

Clear cell data Delete Delete

Clear cell formats Alt   H   E   F

Clear cell comments Alt   H   E   M

Clear all Alt   H   E   A   

Borders

Outline border Ctrl  +   + & Ctrl  +   + &

Remove border Ctrl  +   + - Ctrl  +   + -

Left border Alt   H   B   L ⌘  + Opt  + ←

Right border Alt   H   B   R ⌘  + Opt  + →

Top border Alt   H   B   T ⌘  + Opt  + ↑

Bottom border Alt   H   B   O ⌘  + Opt  + ↓

Paste Special

Paste special formats Ctrl  + Alt  + V    T Ctrl  + ⌘  + V    T

Paste special values Ctrl  + Alt  + V    V Ctrl  + ⌘  + V    V

Paste special formulas Ctrl  + Alt  + V    F Ctrl  + ⌘  + V    F

Paste special comments Ctrl  + Alt  + V    C Ctrl  + ⌘  + V    C

Ribbon

Show ribbon accelerator keys Alt

Show/hide ribbon Ctrl  + F1 ⌘  + Opt  + R

Getting around a worksheet

Move from cell to cell Arrows Arrows

Go to end of contiguous range Ctrl  + Arrows ⌘  + Arrows

Move one screen up PgUp Fn  + ↑

Move one screen down PgDn Fn  + ↓

Move one screen left Alt  + PgUp Fn  + Opt  + ↑

Move one screen right Alt  + PgDn Fn  + Opt  + ↓

Go to cell A1 Ctrl  + Home Fn  + Ctrl  + ←

Go to beginning of row Home Fn  + ←

Go to last cell in worksheet Ctrl  + End Fn  + Ctrl  + →

Open the Go To dialog box F5 F5

Selecting data in a worksheet

Select a cell range   + Arrows   + Arrows

Highlight a contiguous range Ctrl  +   + Arrows ⌘  +   + Arrows

Extend selection up a screen PgUp Fn  +   + ↑

Extend selection down a screen PgDn Fn  +   + ↓

Extend selection left a screen Alt  +   + PgUp Fn  +   + ⌘  + ↑

Extend selection right a screen Alt  +   + PgDn Fn  +   + ⌘  + ↓

Select all Ctrl  + A ⌘  + A

Data editing

Fill down from cell above Ctrl  + D Ctrl  + D

Fill right from cell left Ctrl  + R Ctrl  + R

Find and replace Ctrl  + F Ctrl  + F

Show all constants F5   Alt   + S   O 

Highlight cells with comments F5   Alt   S   C 

Data editing when inside cell

Edit the active cell (Edit mode) F2 F2

While editing cell, allow use of 
arrow keys to create reference

F2 F2

Confirm change and leave cell Enter Return

Cancel cell entry and leave cell Esc Esc

Insert line break within cell Alt  + Enter Opt  + Enter 

Highlight within a cell   + ←  or →   + ←  or →

Highlight contiguous items Ctrl  +   + ←  or → Ctrl  +   + ←  or →

Jump to beginning of cell Home

Jump to end of cell End

Delete character to left Backspace Delete

Delete character to right Delete Fn  + Delete

Accept AutoComplete suggestion Tab Tab

Reference a cell from another 
worksheet

Ctrl  + PgUp  Arrows  

Ctrl  + PgDn  Arrows

Ctrl + Fn + ↑      Arrows  

Ctrl + Fn + ↓      Arrows

Windows Mac Windows Mac
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Find shortcuts for previous Excel versions at 
at www.wallstreetprep.com/excel-shortcutsExcel 2016 Shortcuts

Calculations

Start a formula =  =

Insert autosum formula Alt  + = ⌘  +   + T

Recalculate all worksheets F9 F9

Anchor cells (A$1$),  
toggle anchors (edit mode)

F4 F4

Open Insert Formula dialog   + F3   + F3

Enter array formula (edit mode)   + Ctrl  + Enter   + Ctrl  + Enter

Auditing formulas

Inspect cell values (edit mode) F9  F9 

Switch to formula view Ctrl  + ~ Ctrl  + ~

Select direct precedents Ctrl  + [ Ctrl  + [  

Select direct dependents Ctrl  + ] Ctrl  + ]

Trace immediate precedents Alt   M   P

Trace immediate depedents Alt   M   D

Remove tracing arrows Alt   M   A   A

Go to last cell F5  + Enter F5  + Enter

Excel Utilities

Calculate all open workbooks F9  F9 

Open Excel Options dialog box Alt   F   O ⌘  + , 

Accessing data validation Alt   A   V   V

Get inside a drop-down list Alt   ↑  or ↓ Opt  + ↑  or ↓

Insert data table Alt   A   W   T

Open Sort dialog Alt   A   S   S ⌘  +   + R 

Autofilter selection Alt   A   T

Insert a pivot table Alt   N   V

Insert a chart Alt   N   R

Zoom Alt   W   Q Ctrl  + Mouse scroll 

Name a cell or cell range Ctrl  + F3 Ctrl  + L 

Rows and Columns

Select column Ctrl  + Space Ctrl  + Space

Select row   + Space   + Space

Delete row(s)/column(s) Ctrl  + - Ctrl  + - 

Add row(s)/column(s) Ctrl   +   + + Ctrl  +   + + 

Set column width Alt   H   O   W

Autofit column width Alt   H   O   I

Fit to specific row height Alt   H   O   H

Group rows/columns Alt  +   + → Opt  +   + → 

Ungroup rows/columns Alt  +   + ← Opt  +   + ← 

Navigating across worksheets and panes

Jump to next worksheet Ctrl  + PgDn Opt  + →

Jump to previous worksheet Ctrl  + PgUp Opt  + ←

Change worksheet name Alt   H   O   R

Rearrange tab order Alt   H   O   M

Freeze pane Alt   W   F   F

Split screen Alt   W   S

Toggle from tab, ribbon, task 
pane, status bar

F6 

Close help (and other panes) Ctrl  + Space  + C

Moving inside Excel forms (format dialog, page setup, etc.)

Move to next control Tab  Tab 

Move from tab to tab Ctrl  + Tab Ctrl  + Tab 

Move to previous control   + Tab   + Tab 

Move within a list Arrows Arrows 

Activate control Alt  + Underlined Ltr

Toggle checkboxes Spacebar Spacebar 

Close a dialog Esc Esc 

Apply change Enter Enter

Optimal Excel settings (PC and Mac) Disabling conflicting Mac OS shortcuts

A Note on Mac function keys

1. Calculation options

Open Excel settings/preferences (Alt T O on Windows, 

Ctrl + , on Mac). Under "Calculation options," (under the 

"Formulas" tab in Windows), chose "Automatic except for 

data tables" and click on "Enable iterative calculation."

2. Disable Autocomplete

Open Excel settings/preferences. Click off "Enable Auto-

Complete for cell values. In Windows, this can be found 

under Options > Advanced > Editing Options.

3. Disable Error Checking

Open Excel settings/preferences. Click off "background 

error checking." (Found under the "Formulas" tab in 

Windows.)

Enable Ctrl + Arrows by disabling  
Mission Control settings

1. Go to System Preferences > Keyboard. 

2. Go to “Keyboard shortcuts” tab. 

3. Click “Mission Control” in the left window. 

4.  Expand the “Mission Control” tab in the 

right window and click off “Move left a 

space” and “Move right a space”

Enable Ctrl+Spacebar for highlighting  
columns by disabling Spotlight Search

1. System Preferences > Keyboard. 

2. Go to “Keyboard shortcuts”s” tab. 

3. Click “Spotlight” in the left window. 

4. Disable “Show Spotlight Search.”

By default, Mac function keys control system settings and Mission Control. To use function 

keys for shortcuts, you'll need to hold down the "fn" key before you press F2, F3, etc. You 

can change this in System Preferences > Keyboard by checking "Use all F1, F2, etc. keys 

as standard function keys." You can now use the function keys without pressing "fn."

Windows Mac Windows Mac
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